
Satmaster QuickAim User Guide Mk4.x
Satmaster QiuickAim is a simple program designed to  run on Win9x/NT/2000/XP or Vista. This is 
a quick start guide in using the software (see help file for more detail).

For sales, enquiries or support relating to this product please contact: 

DJ Stephenson , Arrowe Technical Services
58 Forest Road, Heswall, Wirral, CH60 5SW, England.
Tel  UK: 0151 342 4836 Tel International  +44 151 342 4846
Fax UK 0151 348 4263 Fax International +44 151 348 4263
email: (see website for contact form, current email address is sometimes changed due to spam 
noise)

Web Sites:
http://www.arrowe.co.uk
http://www.arrowe.com
http://www.satmaster.co.uk
http://www.satmaster.com

Getting Started: 
Here is a quick summary to start using QuickAim.  The most often used toolbar button is the 
“Edit” button shown below.

• This button brings up the associated input form for editing any of QuickAim's files. Pressing 
the “F12” hot key performs the same action. Press the F1 key on any active edit control (input 
field) and help on that particular parameter is displayed. An additional help cursor button is 
also present at the top right of all input forms.

Overview

• Calculates look angles and polarization offset of any geo-stationary satellite.
• Uses US Zip codes, GPS input, manual or global database inputs for site location.
• Uses manual or pick from list inputs for satellite selection.
• Automatic magnetic variation and compass bearing calculations. 
• Atmospheric refraction is taken into account for low elevations.
• Produces tables of “visible” satellite for any global location.
• Finds multi-satellite modified polar mount tracking angles.
• Generates tables of look angles for major towns and cities in a chosen country.
• Calculates dual/multi feed spacing.
• Fully user-editable databases.

Installation

• Run the file “Setup.exe” from the chosen storage medium and respond to the on screen 
prompts.



The install program, setup.exe, decompresses files to your hard disk and sets up an optional 
program group containing Satmaster QuickAim and other icons. Satmaster QuickAim is removed 
via the “”Add/Remove Programs” option in the control Panel. “Distributor Information” fires up 
“vendor.rtf” which is the distributor’s contact and product information. When uninstalling, we have 
taken care to clean the registry entries properly, unlike some applications.

System Clock
Please ensure the date of your system clock is correct, so current magnetic variation values may 
be calculated. It should be noted that the best possible accuracy, using any global model, is + or - 
0.25 degrees.

Running QuickAim
The program starts with a standard menu and button toolbar interface.  The menu-bar gives 
access to the File, Edit, Map, Graph, Table, Calculate, Window and Help menus.

There are 4 basic file types that QuickAim uses these are:

• Look-angle files (*.ang).

• Dual feed files (*.duo), 

• Country data files (*.twn), 

• A single Satellite data file (satlist.geo).

The satellite database may need updating from time to time as replacements are launched or 
moved.  The (*.geo) and (*.twn) database files are fully editable and may be modified or 
appended by the user at any time (see Help file for details).  To save time the latest file 
‘satlist.geo’ can also be downloaded from our web sites above.

Help Facilities
Help is organized as follows:

•     The status line at the bottom of the screen expands on menu selections where necessar
•     The Toolbar has a glide over facility so the  toolbar button’s function is given in text.
•     Whenever a dialog box edit control is activated, the status line may advise on a range of 

values to enter.
•     Additionally, pressing the F1 key while a dialog box’s individual edit control is active will 

display more detailed information on that particular input parameter. There is also a help 
cursor button in the top right hand corner of each dialog box, which performs the same action, 
with a drag and click operation.

•     Each dialog box (form), has its own help button which may be clicked to display background 
and more detailed information about input parameters.

Input forms and Dialog Boxes
QuickAim uses input forms, traditionally called “dialog boxes”. This makes input validation 
comprehensive and allows the user to call up help as necessary for assistance with range, type 
and definition of input values.  All input is validated in an attempt to make the program ‘crash-
proof’ and rejects ridiculous input data where possible. Some forms can be cleared by clicking the 
“Clear” button.



Opening a New File
Click File|New to bring up the new files sub-menu and select the file type you wish to create.

Toolbar
The toolbar buttons duplicate the more frequently used menu selections.  The most useful is the 
‘Edit Active Document” button shown below.

This is easily the most often used toolbar button in the program.

In order, left to right, the buttons represent:

Load an existing file; Save file; Edit active document; Copy all; Paste; Print; Print preview; Tile 
open windows; Cascade open windows; and finally Help. 

File Menu
Use this option to save, open, print, or create new files.  There are several different file types.  If 
you select ‘New’ the appropriate form is displayed for the file type selected.  Simply complete it 
referring to Help where necessary.

To open an existing file, select ‘File|Open’ to display the file open dialog and select the file type 
from the ‘Files of Type’ list box. Finally, double click on the selected file name to load it into 
memory.

Editing Files
The following sections show how to produce a look angle file followed by how to create and edit 
the country and satellite databases.  Creating and editing other file types is a very similar 
process.

Look Angle Files (*.ang)
This file type is used to calculate antenna installation data.  Click on File | New and select “New 
Look Angles” from the menu.  An empty ‘Look Angles’ window and a form is displayed.  Normally, 
the Inclination, Polarzation cant and Offset focus angle values can be set to zero, which are the 
preset default values when the form is opened. You only need to use these three inputs for more 
detailed requirements. For convenience, you may transfer data into the ‘Look Angles’ dialog box, 
or any other dialog box equipped with a ‘Site’ button, from the country town/city database.

Pressing the ‘Site’ button displays an ‘Open Country Data File’ form to select a particular country 
file.  Entering the first letter of the country from the keyboard quick scrolls the list box. When the 
country file has been selected, click the ‘Open’ button to display the list box of towns and cities 
associated with the selected country.  Again, entering the first letter of the town form the keyboard 
quick scrolls the list box to a more convenient start point. For US sites you have a faster 
alternative, simply click the “Zip” button and enter a valid US Zip Code into the form However, use 
this facility with caution, it is suitable only for densely populated urban areas. Similarly, data from 
the satellite database file ‘satlist.geo’ may be transferred into any form equipped with a ‘Satellite’ 
button simply by double clicking on the required satellite from a list box.  Entering the first letter 
letter from the keyboard can repeatedly quick scroll the list box to find setellites quickly. The list is 



ordered by longitude.

When you have completed the ‘Look Angles’ form you may click OK to trigger the calculation. 
You may also close the form without loosing any entered data by clicking the ‘Cancel’ button. 
You do not loose any input data you have entered unless the associated Window is closed as 
well. 

Once you have triggered the calculation, the associated window displays the calculated data and 
the parameter file may be saved with the ‘.ang’ extension.  To do this select ‘Save As’ from the 
‘File’ Menu to display the “Save As” dialog and enter a chosen filename.  It should be pointed out, 
that only the input parameters are saved, not the text itself.  If you wish to save the text portion as 
a simple text file then select ‘Save As Text’ from the ‘File’ menu. You may also copy the text to 
the clipboard, as ‘tab delimited text’, for directly pasting into a spreadsheet or similar application. 

Dual Feed Files (*.duo)
These files are similar to look angle files but also calculate the relative satellite spacing and (x,y) 
feed mounting positions for dual feed systems. Repeat as often as necessary for multiple feed 
systems.

Country Data Files (*.twn)
Country data files contain latitude and longitude site co-ordinates for major towns and cities. 
There are about 250 country files with up to 1800 entries each.  This data can be used either to 
edit forms equipped with a ‘Site’ button or generate various tables such as ‘International Look 
Angles’ under the ‘Tables’ menu.  There may be the odd discrepancy where the precise borders 
of a particular country may be, or recently been, in a fluid state.  Select ‘File|New’ to start a new 
custom file.

To edit an existing country file:

• Click ‘File’ then ‘Open’.  The Open dialog is displayed.
• Select ‘Country Files (*.twn) from the ‘List Files of Type’ pull down listbox.
• Select the file of the country of interest (eg.  uk.twn).  A window should appear containing a 

list of all the towns and cities currently stored.
• Click the toolbar edit dialog button or select ‘Edit Active Document’ from the ‘Edit’ menu.  The 

‘Edit Town/City Data’ dialog appears (shown below).
• Click on the name of the town/city you wish to amend then click the modify button (double 

clicking on the town/city goes straight to modify).  The ‘Modify Town/City Record’ dialog 
appears.  You can also change the name of the country as it appears on reports and printouts 
by clicking the ‘Edit Country Name’ button.

• Edit the Town/City name and co-ordinates as necessary then click the ‘Done’ button.

You may also add new town/city records by clicking the ‘Add’ button.  The form is similar to the 
modify species and is shown partially completed below. Always enter this data in 
degrees.minutes format.

Satellite Data File (satlist.geo)
A database of geo-stationary satellites, their locations and active bands are stored in a single file 
called ‘satlist.geo’.  Select File|Open then select ‘Satellite File (*.geo)’ from the ‘list files of type’ 
drop down list box in the ‘Open’ file dialog.  Select the file ‘satlist.geo’ and its contents will be 
displayed in a window.  Click the 'edit' toolbar button to edit in a similar manner to the town/city 
files.  This file is used to generate lists of craft, which are ‘visible’ from a chosen location.  See 
‘Satellites Above Horizon’ available under the ‘Tables’ menu.  Another use is quick entry of 
satellite data into look angle and dual feed input forms.



Map Menu
There are two other reference diagrams one is called ‘Polar Mount Diagram’ and the other is 
‘Polarization Offset Diagram’.  These diagrams clarify the angle terminology used in the program.

Graph Menu
The ‘Graph’ menu allows you to plot modified polar mount data and focal point graphs. Select the 
required graph from the ‘Graph’ menu and fill in the corresponding form (if required). Context 
sensitive help is available on all input fields. Each graph is plotted in a new window and may be 
either printed out or copied to the clipboard.

Table Menu
Select the required table from the ‘Table’ menu and fill in the form associated with it. The table of 
results is displayed in a new window and may be either printed, saved as an unformatted text file 
or copied to the clipboard as tab delimited text. The status bar also displays the order of the table 
columns.  This may be helpful if the table headings are scrolled out of view

Look Angle, Dual Feed and Satellites Above HorizonTables
Particularly useful options under the ‘Tables’ menu are ‘International Look Angles’ and ‘Dual Feed 
Spacing’.  For all major towns and cities in a selected country, the former builds a table of look 
angles to a particular satellite and the latter a table of relative satellite and feed spacing.  A further 
useful table is ‘Satellites Above Horizon’ which generates a table of look angles for all satellites 
‘visible’ from a particular site.

Calculate Menu
Facilities to calculate antenna focal distances and conversions for degrees:minutes:seconds 
(D:M:S) to degrees and vice versa are available under this menu. Simply complete the input form 
then click the “OK” button to calculate. Click the “Cancel” button when finished with it.

Options Menu
Currently there is only one option under this menu and that is “Setup”. The “Setup” form is used 
to set default options,  persistence of options and setup the GPS COM port (see help file for full 
details).

Window Menu
This menu helps you tidy up and organize the application’s windows.  Choosing ‘Cascade’ 
arranges all open windows in a staggered and overlapped fashion.  Choosing ‘Tile’ shrinks and 
arranges all open windows into a tile design either vertically or horizontally as requested. ‘Close 
All’ closes all open windows and leaves a clear application window.  There are also toolbar 
buttons for ‘Cascade’ and ‘Tile Vertically’.

Help Menu
Selecting “Satmaster Help Contents” offers more detailed information on how to use QuickAim. 
There is also an  “About” selection which displays current version details.

Copying Output to Spreadsheets
The entire contents of any window may be copied to the clipboard in a single operation. 
Selecting “Edit|Copy” or clicking the toolbar’s copy button initiates this process.  Output can then 



be pasted directly into a spreadsheet application, such as Excel, for quick customization without 
re-formatting.

Data Conventions
QuickAim requires the following rules to be observed when entering or interpreting values of 
latitude, longitude or magnetic variation.  All units are degrees unless otherwise stated.

Latitudes NORTH  suffixed by N (eg 53.33N)
Latitudes SOUTH  suffixed by S  (eg 10.34S)
Longitudes EAST suffixed by E  (eg 19.2E)
Longitudes WEST suffixed by W (eg 3.1W)
Magnetic variation EAST  suffixed by E (eg 3.0E)
Magnetic variation WEST suffixed by W (eg 3.0W)

Latitudes and longitudes, are usually obtained from maps and atlases in degrees & minutes 
format, whilst satellite longitudes are often quoted in decimal degrees.  When using QuickAim, 
always use decimal degrees for all input fields with the exception of editing country files outlined 
below.

A convenient conversion facility is provided under the “Calculate” menu to convert from the 
degrees.minutes form to degrees.

When editing country data files it is more convenient to enter and check data in degrees.minutes 
format as obtained from an atlas or map.  QuickAim automatically converts degrees.minutes 
format to degrees as and when the data is used.

Drag and Drop
QuickAim supports the drag and drop standard of loading its file types into the main application 
window.  However, on most small monitors it is doubtful if this facility will be of much practical 
use. Shell features, such as “open” and “print”  are enabled which automatically load QuickAim 
and display (or print) the selected file in a single operation.

Most Recently Used Files
Under the ‘files’ menu there is a list of the six most recently used files.  This enables quick 
opening of any of these files without the need to bring up the open file dialog. In the 32bit version 
these are also added to the “Documents” start menu of Windows 95.

Feedback to Author
Your comments, criticisms and suggestions are always helpful.  If any errors are detected please 
let me know. Contact details are at the head of this document.

This file was produced using OpenOffice.org Writer.


